NYSERDA Report Format and Style Guide

Purpose
This document explains how to prepare a technical report for the New York State Energy Research and
Development Authority (NYSERDA), including typesetting and formatting procedures, and provides
electronic data-transfer information.
The finished report deliverable will be published by NYSERDA. Please direct questions about format and
style to Diane Welch of NYSERDA’s Marketing Services unit at: (518) 862-1090, ext. 3276, or via e-mail:
dlw@nyserda.org.

Americans with Disabilities Act (ADA) Accessibility Compliance
As a State Authority, NYSERDA is obligated, under Section 508 of the Rehabilitation Act (29 U.S.C.
794d), as amended by the Workforce Investment Act of 1998 (P.L. 105-220), August 7, 1998, to ensure
that all documents published on NYSERDA's website are accessible.
To meet the needs of persons with visual disabilities, reports must be in a format that allows for conversion
of written words of an electronic document into speech, thus allowing the person with a visual disability to
hear the text. The formatting of these documents is critical to the success of the conversion from text to
speech. Reports submitted to NYSERDA must meet the following requirements:
•
•
•
•
•

Format documents using Microsoft Word Styles
Use headings in the document
Use Alternate Text (Alt Text) for images and objects
Provide captions for all tables, images, and figures
Use contextual links, do not use long URLs or "click here"

For more information about how to make a document accessible, please refer to
http://nyserda.ny.gov/resources/

Page Format
Proper page setup is essential to ensure that your report is published accurately and efficiently. Textual
material should be created in Microsoft Word. While other word-processing programs may be able to be
converted, file corruption may occur during the process. Reports that are to be published on the web must
be submitted as either a Microsoft Word document, or a fully accessible PDF in NYSERDA's approved
format, which contains all of NYSERDA's Marketing Department editorial changes.
•
•
•
•
•

Left and Right margins should be set at 1.25 inches; Top and Bottom margins should be set at 1inch
Use left-hand justification only
Spacing should be 1.5 lines
Block-style paragraphs should be used, with no indentation (except for fifth-level headings, which
should be blocked on the left; see Heading Styles on page 6 of this guide)
There should be 10pt of space between a paragraph and the heading that follows. (Note: the
spacing above and below a paragraph or heading should be controlled by the use of Styles, and not
through the use of hard or soft returns)
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Report Format and Pagination
Required Components
The following items are required in all technical reports and should be paginated in the following sequence:
•
•
•
•
•
•
•
•

Title page (no page number)
Notice (no page number)
Abstract and Keywords (iii)
Acknowledgments (optional) (iv)
Table of Contents, including listings of figures and tables (v)
Summary (S-1)
Main Text listed by section number (1-1; 2-1)
Appendices (A-1; B-1)

Note: Each subsequent section or chapter must begin on a new page, but it is not necessary to start each
new section on a right hand (recto) page.

Title Page
The following information is required:
•
•
•

•
•

Report title and type of report (i.e.,
final, interim, or summary)
Name of NYSERDA project
manager(s)
Corporate name, city, and state of
contractor(s), including contact
person(s) or project manager(s)
Project co-sponsors, including contact
person(s) or project manager(s)
NYSERDA Agreement number (e.g.,
NYSERDA 10902)
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Notice
All technical reports are required to contain one of the following legal notices or disclaimers:
•

When NYSERDA is the project’s sole sponsor, this notice must be used:
NOTICE
This report was prepared by Insert Preparer's Name in the course of performing work
contracted for and sponsored by the New York State Energy Research and Development
Authority (hereafter NYSERDA). The opinions expressed in this report do not
necessarily reflect those of NYSERDA or the State of New York, and reference to any
specific product, service, process, or method does not constitute an implied or expressed
recommendation or endorsement of it. Further, NYSERDA, the State of New York, and
the contractor make no warranties or representations, expressed or implied, as to the
fitness for particular purpose or merchantability of any product, apparatus, or service, or
the usefulness, completeness, or accuracy of any processes, methods, or other
information contained, described, disclosed, or referred to in this report. NYSERDA, the
State of New York, and the contractor make no representation that the use of any product,
apparatus, process, method, or other information will not infringe privately owned rights
and will assume no liability for any loss, injury, or damage resulting from, or occurring in
connection with, the use of information contained, described, disclosed, or referred to in
this report.

•

When there are project co-sponsors in addition to NYSERDA, use the following notice instead:
NOTICE
This report was prepared by Insert Preparer's Name in the course of performing work
contracted for and sponsored by the New York State Energy Research and Development
Authority and the Insert Co-Sponsor (hereafter the "Sponsors"). The opinions expressed
in this report do not necessarily reflect those of the Sponsors or the State of New York,
and reference to any specific product, service, process, or method does not constitute an
implied or expressed recommendation or endorsement of it. Further, the Sponsors and the
State of New York make no warranties or representations, expressed or implied, as to the
fitness for particular purpose or merchantability of any product, apparatus, or service, or
the usefulness, completeness, or accuracy of any processes, methods, or other
information contained, described, disclosed, or referred to in this report. The Sponsors,
the State of New York, and the contractor make no representation that the use of any
product, apparatus, process, method, or other information will not infringe privately
owned rights and will assume no liability for any loss, injury, or damage resulting from,
or occurring in connection with, the use of information contained, described, disclosed, or
referred to in this report.

Abstract and Keywords
The Abstract is a brief, approximately 200-word description of project objectives, investigative methods
used, and research conclusions or applications. This information will be used when NYSERDA registers
the report with the New York State Library (NYSL), and the Library of Congress (LOC). A list of
keywords that describe the project and identify the major research concept should be submitted with the
report. Four to six precise descriptors are generally sufficient and will be used for indexing, registering, and
distributing the report through NTIS.
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Acknowledgments
The Acknowledgments must precede the Table of Contents and is generally no longer than two paragraphs
in length.

Table of Contents
The Table of Contents should list section numbers, titles, second-level headings, and their page numbers.
Third-level headings also may be listed. If the report contains five or more figures or tables, they should be
listed using the style of the Table of Contents. (Reference the "Table of Contents" style in the styles menu
of the NYSERDA report Template).
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Headers and Footers
In addition to using paragraph styles to organize and define the structure of a document, elements such as
page numbers, notes, and citations should be placed within a header or footer. These should not be inserted
manually because they will not be included within the marked-up structure of the document (for example
typing out the number 1, 2, 3, etc. at the top or bottom of every page to insert as page numbers). To add a
header or footer to a document, select “Header,” “Footer,” or “Page Number” from the “Header and
Footer” groups on the “Insert” tab.

Footnotes
If possible, please substitute parenthetical in-line text for footnotes in Word to generate a tagged PDF. Any
footnoted text will be read out loud by a screen reader immediately after its reference, as if it were inserted
inline rather than positioned at the bottom of the page. If inserting parenthetical in-line text is not
conducive to your report type, and you are not using Microsoft Word 2007 or higher, the footnotes will not
be properly linked to the referenced text when read by the screen reader.

Hyperlinks
Make sure that all hyperlinks are clearly described in the text surrounding the link. Do not use “Link” or
“Click here.” Ensure that the text in the link tells the readers what they are going to find if they click on the
link. Listing the URL to a website as a link, for example http://nyserda.ny.gov, is preferred.

Illustrations
This section explains how to insert an image, photograph, logo, figure, chart or diagram.
•
•
•
•

Select the “Insert” tab
Choose “Picture”
Browse to the image or graphic
Click “Insert”

Images (Photograph)
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Graphics (Logo or Figure)

Note 1: Images without substantive content should not have any Alternate Text.
Note 2: Background images or watermarks do not have to be tagged. When the document is converted to a
PDF file, these images will not be detected by the screen reader.

Charts or Diagrams
5
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Captions
Ensure that the caption text is descriptive, not just a label. Please consider the following examples:
•

•

Do not use: “This is a photo of a steam plant.”
Use: “The photo shows the location of the filtering system mounted to the primary stack that
collects particulates and unburned gases, which are then rerouted through the secondary burner.”
Do not use: “This is Figure 12.”
Use: “Figure 12 shows that 17% of the targeted age group in the Astoria neighborhood of Queens
has participated in this program, versus 43% of the targeted age group in the Park Slope
neighborhood of Brooklyn who first participated in an energy-savings competition.”

Photographs, figures, charts, and graphs must be explained in Alt Text for the visually impaired reader.
In some circumstances, it may be necessary to import tables as images. When this is the case, Alt Text must
also be included (refer to NYSERDA’s ADA Accessibility Requirements document located at:
http://www.nyserda.ny.gov/resources/~/media/Files/About/Style%20Guide/ADA%20Accessibility%20Req
uirements.ashx on NYSERDA's website for assistance with Alt Text).
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To insert a caption, right click on the object and select "Insert Caption."
•
•

Captions for tables are traditionally inserted above the table
Captions for images and figures are traditionally inserted below the image

Tables and Figures
•
•
•
•
•
•

•
•

•

Tables and figures must be numbered sequentially and titled individually
Place tables and figures as close as possible to the text in which they are mentioned
Distinguish tables from the text by using a table style
Cite a source if the tabular material or figure content has not been generated by the contractor
Figure captions should be complete sentences when appropriate
Use "Figure 1," not "Fig. 1," or "Table 1." in the text, as well as for captions. Examples:
“Table 1 details demand-side management options”
“As shown in Figure 1, the demand-side management program offers numerous options”
Figure captions should use the style “Strong”:
Figure 1. Demand-Side Management Options in New York State.
Unless generated by the contractor, a source should always be cited. The figure source should
appear after the caption:
Source: Lawrence Berkeley Laboratory)
Photographs and drawings should only be inserted if they are meaningful to the report. The
following styles are typically used:
o
o
o

Black-and-white line drawings
Clear halftones (black-and-white photographs)
Color artwork and photos
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Font Styles and Formatting
All text elements should be set in 10-point Times New Roman; all caption, tables, and figures elements
should be in 10-point Arial or Helvetica.
The format of selected text in the document text can be easily changed by choosing a look for the selected
text from the “Quick Styles” gallery on the Home tab. One also can format text directly by using the other
controls on the “Home” tab. Most controls offer a choice of using the look from the current theme or using
a format that is specified directly.

Using Styles to Add Structure
Microsoft Word does a good job of encouraging the proper use of Styles. The “Styles” group is found on
the “Home” Tab. To change a section of text, simply select the text and click on the appropriate style. In
addition to making the document look better, “Styles” also allows for the creation of automatic PDF
bookmarks, TOC links, and PDF tags.

Common Styles
Headings
Microsoft Word has nine built-in “Heading” styles. They are called Heading 1, Heading 2, etc. A person
would use the “Heading” styles to indicate major headings in a document. Use Heading 1 to indicate a toplevel heading. If there is a sub-heading for Heading 1, use Heading 2. If there is a sub-heading for Heading
2, use Heading 3, and so on. Again, it is adding structure to the document and, structurally, the headings
should be used in order. For example, do not use Heading 1, then Heading 3 simply because the writer likes
the way Heading 3 is formatted. Instead, modify Heading 2 to the writer's liking and use Heading 2 before
using Heading 3.

Numbered Lists
The “List Number” style can be used when there is a numbered list. Do not use the buttons on the toolbar to
indicate a numbered list. The “List Number” style is more stable and will be easier to maintain.

Bulleted Lists
The “List Bullet” style can be used when there is a list of items, and order does not matter. If the order of
the list items is important, use the “List Number” style instead. Do not use the buttons on the toolbar to
indicate a bulleted list.
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Emphasis
The “Emphasis” style can be used to indicate that a word(s) are important. The default format for the
“Emphasis” style is italic. Visually, using the “Emphasis” style on a word or words looks the same as if the
writer simply clicked the italic button on the formatting toolbar. However, for someone using a screen
reader, it can tell the individual that the writer thinks that word or words are important. A screen reader user
will not know if a word is simply italicized, but with the “Emphasis” style, a screen reader user could
“learn” that the writer has emphasized that particular text.

Strong
The “Strong” style is similar to the “Emphasis” style except that the default format is bold. It gives
structure to words, rather than simply changing the way a word or words look.

Title
The “Title” style is used to indicate the title of the document. There should be only one “Title” style in use
in a given document.

Body Text or Normal
The “Body Text” style can be used to indicate the text in the body of the document. The “Normal” style is
very similar and can be used instead of the “Body Text” style.

Creating New Styles
If NYSERDA's Report Template does not encompass every style required in your report, you can create
additional styles for formatting. There are two ways to do this: “New Styles” or “New Quick Styles.” To
create a new style:
•
•
•

Click the “Styles” dialog box
Click the “New Style” button
Complete the “New Style” dialog box

At the bottom of that dialog box, one can choose to add this to the “Quick Style” list or to make it available
only in this document. Please note that you should not be changing NYSERDA's template styles, as these
are the approved formatting for NYSERDA published documents.

Tips
•
•

•

Do not fling formatting at text. "Flinging" means creating a style that looks like a heading or
subheading, but really is a different font style, size, bold, italicized, etc.
Screen reading software will read the document as one long series of paragraphs with no
differentiation for new topics unless properly formatted with Heading Styles. (Imagine reading a
textbook with no difference in text from one paragraph to the next.)
When documents are converted to other formats (HTML, PDF, PowerPoint, etc.), the heading
structure is retained automatically.
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Copyrights
Intellectual Property
All material borrowed or adapted from other sources should be properly identified (i.e., document, source,
date, and page). The contractor must obtain and submit to NYSERDA the copyright owner’s written
permission to use any illustrations, photographs, tables, figures, or substantial amounts of text from any
other publication.
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Report Submission Guidelines
No printed drafts of the report are required. An electronic Word version must be submitted to your
NYSERDA Project manager. After review by your Project Manager and Marketing Services staff, a final
draft will be returned to the contractor for review, additional corrections, and approval. The contractor is
responsible for satisfactorily addressing technical comments from NYSERDA and other co-sponsors.
When making editorial corrections, the contractor must ensure that technical content is not compromised.
After editorial corrections have been made, the contractor must submit a final electronic "Word" version of
the final report. Material may be submitted using one of the following methods:
•

FTP Site:
Install a Secure File Transfer Protocol (SFTP) client. (We recommend Filezilla
(http://filezilla-project.org/download.php)

The following are NYSERDA's SFTP credentials:
Host: 66.109.33.102
Port: 49122
Server Type: SFTP
Logon Type: Normal
User: NYSERDA-General
Password: yedg!n
•
•

Email: to your project manager, or NYSERDA's Marketing department: print@nyserda.org
Compact disc (CD-ROM):
NYSERDA — Marketing Services
Attn: Diane Welch
17 Columbia Circle
Albany, New York 12203-6399

If you are unable to meet these electronic transfer requirements prior to submitting your report, please
contact Diane Welch of NYSERDA’s Marketing Services unit at: (518) 862-1090, ext. 3276, or
via e-mail: dlw@nyserda.org.
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